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INTRODUCTION 
 

Recording birds provides a permanent record of their vocalizations, and allows comparisons 
within and between individuals, sexes, ages, and species, over time and across habitats and 
behavioral contexts.  Sound analysis software can produce visual representations of sound that 
reveal details of song and call structure, and are a powerful tool to help visually-oriented humans 
train ourselves to discriminate sounds by ear.  These labs will provide hands-on experience with 
the recording and analysis techniques that are used to explore the diversity and functions of 
sounds made by birds.  The chapter on vocalizations in your ornithology textbook, and 
references given there, are good places to start reading about this topic.  Robbins et al. (2001) 
includes sound spectrograms for many species; on pages 12-13 they provide useful guidance for 
learning to recognize spectrograms of different types of sounds.  Pieplow's (2017) Peterson Field 
Guide to Bird Sounds includes multiple examples for each species, and has an accompanying 
website where sounds can be played as their spectrograms scroll by, at 
https://academy.allaboutbirds.org/peterson-field-guide-to-bird-sounds  (NOTE:  type the name 
into the Search bar, but then you need to select the species from the drop-down menu.  If the 
Search bar does not appear on your browser, try another browser.)  Additional spectrograms (and 
a great deal of other information about each species) may be found in the Birds of North 
America online species accounts, birdsna.org, to which your library may have a subscription. 
 
Recordings and playback experiments are used by biologists for a variety of kinds of studies: 
 
1) Identification and censusing.  Sound spectrogram representations of vocalizations help to 
focus attention on details of song structure and delivery that can be used to distinguish similar 
species.  Recordings made during censuses allow researchers to identify species and document 
their presence; in some species, consistent variations in vocalizations may allow identification of 
particular individuals and improve accuracy of counts when there is some question about 
whether the same bird was singing in different recordings.  High-quality playbacks of recorded 
vocalizations of a species may be used in a controlled and limited way in censusing, to lure 
conspecifics to respond by approaching and/or vocalizing.  
 
2) Description (of individual vocalizations, of timing and sequencing in groups of vocalizations, 
and of wider behavioral context such as interactions with other individuals).  Spectrograms and 
ocsillograms allow for detailed quantitative measurements.   
 
3) Question and/or hypothesis generation and testing.  Quantitative measurements can lead to 
questions and hypotheses:  Why do some bird species vocalize at much higher rates than do 
others?  What is the significance of the frequency range used by a species for its vocalizations, 
and does this correlate with habitat type (which may favor transmission of some frequencies over 
others), or with frequencies of other sounds in the environment?  Why do some species have 
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large song repertoires and others have small song repertoires?  Why do some species sing songs 
with eventual variety (multiple repetitions of one song type before switching to another) and 
others sing with immediate variety (each song differs from the previous one)?  How do 
vocalizations of the same individual differ in different behavioral contexts?  How do 
vocalizations of different individuals in the same species vary in what appears to be the same 
behavioral context?  What, if any, is the communicative/behavioral significance of variations in 
the number of times each syllable type is repeated within a call or song?  When more than one 
individual is vocalizing, are vocalizations timed to avoid or promote overlap?  Can birds 
recognize particular individuals of their own species by their vocalizations?  How closely do 
birds that mimic other species (e.g., mockingbirds) replicate the vocalizations that they are 
imitating, and do the mimicked species appear to distinguish the imitations from sounds 
produced by their actual conspecifics?  Etc.! 
 
Kroodsma (2005) provides a wonderful introduction to the science and joy of listening to and 
analyzing birdsong, written for the general public but with enough ideas to keep researchers busy 
for decades to come.  For additional reviews of many kinds of studies of bird vocalizations, 
including comments on appropriate experimental playback methodology, see Catchpole and 
Slater (1995), Marler and Slabbekorn (2004), and Kroodsma and Miller (1982, 1996).  The first 
two books assume only a general biological background and some familiarity with ornithology 
or animal behavior; the latter edited volumes are essential compilations for researchers in the 
field of avian vocalizations, with some chapters that are broadly accessible and others that 
require considerable background knowledge.  Additional useful information on methods in this 
field can be found in Hopp et al. (1998). 

 
LEARNING OBJECTIVES 

 
 The student will:  -- learn techniques for recording bird vocalizations with a smartphone (Part 1) 

-- learn to use Raven Lite software to perform sound analyses, providing a window into variation 
within and between individuals of the same species, and into between-species variation in styles 
of vocalizing (Part 2)   -- learn to make informative measurements from displays of frequency vs. 
time (sound spectrograms) and amplitude vs. time (oscillograms) (Part 2) 
 

MATERIALS 
 
For each group of 2-3 students:  
-- At least 1 smartphone. Each student who has a smartphone should bring it, with an appropriate 
recording app downloaded (voice memo recorders are not adequate for recording wild birds). 
-- Instructions for downloading and using TwistedWave and RecForge recording apps 
(Appendices A and B), or other recording apps you're using (see Appendix F for relevant 
information) 
-- 1 smartphone microphone with a windscreen (these should be supplied in the lab) 
-- Earbuds or headphones (brought by students), and disinfecting wipes 
-- 1 clipboard with data sheets (data sheet template in Appendix D) 
-- Raven Lite software installed on a Mac or PC in a computer lab  
For class as a whole:  -- Laser printer that can connect to computers the class is using for sound 
analysis.  If computers don't have built-in microphones, also have microphones available. 
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NOTES TO INSTRUCTORS 
 
Essential pre-testing:  It is essential that instructors work entirely through both the Recording and 
the Sound Analysis parts of the lab far enough in advance that you can work with your IT staff 
(and the Raven support staff, if need be) to resolve any problems or confusion on procedures 
before your class.  If you have access to both an Apple and an Android smartphone, you could 
try making recordings with each, but if not, even a test with whichever you have will be useful 
for troubleshooting.  Students are likely to be familiar enough with their phones to navigate some 
variation.   
 
If your computers/monitors don't have built-in microphones, it will be simplest just to have 
students record their own voices on their smartphones, and e-mail those files to themselves, 
along with their files of bird recordings.  You may then omit steps 1, 3, and 4 of the Part 2 
(Sound Analysis) instructions, and re-number the other steps accordingly.  Run a test of 
computer lab computers (both Macs and PCs, if you will be using both) with a student account to 
determine how the students will open Raven Lite (icon on a desktop?  file in a folder 
somewhere?), and test the instructions for students to download sound files from e-mail 
attachments for access with Raven Lite.  Modifications to instructions may be necessary, 
depending on the type of computers and your institution's security settings.  You'll also need to 
know where on your computers Raven software has been installed, so you can navigate back to 
the Raven Examples folder as needed to access sound files (if needed, you can revise that 
information in step D at the end of the Part 2 instructions).  It's also important to test in advance 
your ability to print JPEG-format images and to make adjustments with your printer software to 
fit images to your paper. 
 
This lab is designed to be somewhat modular, and to allow you to make modifications you find 
useful.  Students should be familiar with spectrograms from their textbook before making 
recordings.  If you do not provide both the Recording (Part 1) and Sound Analysis (Part 2) 
instructions at the same time, provide the Appendices with whichever instructions you provide 
first, as they include information relevant to both parts of the lab.  As students make recordings, 
they will need extra copies of the data sheet (template in Appendix D), and they will find it 
convenient to have a double-sided, single-page copy of the step-by-step recording instructions 
for the app they are using (Appendix A or B).  If you discover new capabilities that are useful, or 
have other information to convey to the authors, we'd be happy to hear from you at our e-mail 
addresses on the first page.  For troubleshooting installation or use of Raven Lite, the Raven 
support staff at Cornell are very helpful, and can be e-mailed at:  <raven_support@cornell.edu>  
 

Lab last modified February 2018 
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PROCEDURE 
 

Making the Recordings (Part 1) 
 

Terminology Used to Describe and Analyze Bird Vocalizations 
 
Definitions below are modified from Charif et al. 2006:  Raven Lite 1.0 User’s Guide, and Gill 
(2007). 
 
Vocalization:  A sound produced by the vocal apparatus (for birds, the syrinx and associated 
resonating structures).  (Some birds also make sounds with their wings, feet, and other body 
parts, which you may also record and analyze.)  Vocalizations are often subdivided into Songs 
and Calls, depending in part upon their structure and in part upon their function and sometimes 
on other criteria such as taxonomy and whether they are learned or innate. “Songs” is the term 
generally used to refer to the often pure-toned and complex learned vocalizations made by 
Oscine Passerines and used to proclaim territory boundaries and attract mates (among other 
functions); “Calls” generally refers to all other avian vocalizations; calls tend to be shorter than 
songs, with less complex structure, and often with broader ranges of frequencies emitted 
simultaneously (as in “chips” and “hisses”).  Specific calls or sets of calls are often associated 
with specific situations or “messages”, e.g. “predator warning calls”, “mobbing calls”, “begging 
calls”, etc.  Note, however, that the criteria that have been used to separate songs and calls do not 
always group as indicated above, and have proven quite difficult to use consistently.  
 
Frequency:  The number of cycles per unit time in an oscillating sound waveform; often 
expressed in units of hertz (Hz, 1 Hz = 1 cycle/sec) or kilohertz (kHz, 1 kHz = 1000 cycles/sec).  
We subjectively perceive frequency as “pitch” (apparent pitch may vary depending on the 
frequency of other sounds we are hearing at the same time). 
 
Amplitude:  Energy content of a sound, objectively measured in units of sound pressure, but 
subjectively perceived by us as “loudness” (the apparent “loudness” of sounds with the same 
energy content may vary depending upon the amplitude of background noise). 
 
Sound spectrograms (often referred to simply as spectrograms, and also known as sonagrams) 
are one of the two graphical representations of sound that are most commonly used to analyze 
bird vocalizations.  Spectrograms plot frequency on the y-axis and time on the x-axis; amplitude 
is indicated in gray scale images by the darkness of the trace (darker = higher amplitude).  
Spectrograms (and sometimes oscillograms, see below) can be used to study and precisely 
measure features of sounds that are difficult to hear with an untrained ear:  e.g., whether one or 
more frequencies are present in a sound, durations of sounds and silent intervals, and other subtle 
differences between sounds.  With practice, spectrograms can help us to train our ears to hear 
some of these features.  Other features they show may never be perceptible to our ears, but still 
may be meaningful to the animals that produce these sounds.   
  
Oscillograms are the other graphical representations of sound commonly used to analyze bird 
vocalizations.  Oscillograms plot amplitude on the y-axis and time on the x-axis, and do not 
indicate frequency unless they are expanded enough to determine the number of individual sine 
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waves that fit into one second.  In oscillograms, relative amplitude is indicated by deviation 
above and below the x-axis; louder sounds have greater deviation.  Raven Lite generally refers to 
oscillograms as "waveforms"; the two terms are used interchangeably in the Sound Analysis part 
of this lab. 
 
Tone:  A sound or portion of a sound containing only a single frequency; pure-toned sounds are 
often described as “whistles”. 
 
Note:  A continuous sound (represented by a continuous trace on a spectrogram). 
 
Syllable:  Modular unit of vocalization, consisting of a single note or of a series of notes that is 
consistently given together in the same order.  Many bird songs have repeated series of single-
note or multi-note syllables, and pauses between notes of multi-note syllables are shorter than 
pauses between syllables.  
 
Repertoire:  The number of different notes (note types), syllables (syllable types), songs (song 
types), or calls (call types) given by an individual or species.  “Difference” is generally 
distinguished by examining spectrogram traces, but there is subjectivity in making these 
distinctions, with “splitters” making finer distinctions than “lumpers”, and the possibility for 
different people to base their distinctions on different criteria.  When describing repertoires, it is 
best to describe, as completely as possible, which criteria you used.  Song and call “types” are 
generally distinguished on the basis of the identity of their component syllable types and the 
sequence in which those syllable types are given, while the number of repetitions of each syllable 
type can vary within the same song or call “type”.  
 
Harmonic series:  A set of frequencies consisting of a Fundamental Tone and Harmonic 
Overtones above the fundamental at whole-number multiples of the frequency of the 
fundamental.  The fundamental frequency is also referred to as the “first harmonic”.  Some 
harmonic overtones may be missing from a harmonic series (e.g., a harmonic series could consist 
of the fundamental and then the third, fifth, and seventh harmonic overtones).  Harmonic 
overtones are often seen in spectrograms as a series of similarly-shaped but fainter tracings 
above the darker fundamental. 

 
Questions you may be able to answer with recordings made in this lab 
 
Individuals of most species have repertoires of different vocalizations, and there are also subtle 
variations between renditions of the “same” vocalization, even by a single individual.   Try to 
make recordings that will allow you to analyze similarities and differences between successive 
vocalizations.  These differences may convey different information to listening birds; some may 
also reflect physiological constraints on sound production.   
 
It is unlikely that you will be able to predict in advance which species or vocalizations you are 
going to be able to record, but prepare by reading the following questions so you can make 
recordings that will allow you to answer one or more of them.  See Appendix E for examples of 
the kinds of features you'll be aiming to record and analyze.  
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a) How do successive vocalizations of the same individual differ, in terms of number of notes, 
frequency and amplitude changes within and between notes, and overall duration?   
 
b) What is the duration of silent periods between successive vocalizations, and does this seem to 
be consistent through your recording, or to vary in a regular or apparently random pattern?  
 
c) Is there a regular pattern of increasing and/or decreasing duration of songs or calls within a 
“bout” of singing or calling?   
 
d) Is the duration of a silent pause (which can be used to replenish air exhaled during singing) 
related to the duration of the preceding song or syllable?   
 
e) In species with song repertoires, are songs repeated before a bird switches to a new song 
(eventual variety), or is each song different than the preceding one (immediate variety)?  
 
f) If the behavioral context changes, for example if a bird is singing alone and then a second bird 
starts to sing, are there changes in the content or timing of its songs, or in the rate at which it 
switches between song types?   
 
g) If two individuals of the same species are singing, are their songs timed to avoid overlap, or 
does overlapping occur?  If the latter, does one individual consistently initiate the overlapping (a 
behavior used to challenge the initial singer, in some species) or does each bird start to sing 
before the other bird has finished?  Does this pattern change, in the course of a series of songs?   
Does one bird (which?) eventually chase the other?  
 
h) If a bird moves to a new perch, does it change song types?  Are its initial songs from the new 
perch shorter, or longer, than its last songs from the old perch? 
 
i) If you can record sets of vocalizations from different individuals of the same species in 
apparently similar contexts, does frequency, duration, timing, or some other quality of their 
voices differ in their production of the “same” vocalization?   
 
j) Use your curiosity to ask your own questions as you listen to birds. Think of science as the art 
of collecting interesting numbers, and ask what numbers you might collect that could tell you 
something about the bird you're listening to. 
 
General information on making good recordings 
 
It is a good idea to make (and then listen to) a test recording while you are still inside (you may 
speak into the microphone, or record a sample bird song from an online source, or record 
yourself or a classmate imitating bird vocalizations), to make sure everything is connected 
properly and to practice aiming the microphone and adjusting the recording amplitude.  Be sure 
to read the recording instructions below and the app-specific instructions for your phone 
or tablet in Appendix A or B, and use these as you make your test recordings:  also record 
the relevant information on the data sheet (template in Appendix D).  Ask your instructor 
for help if there is anything you don't understand, or if you are not sure what information 
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to include on the data sheet.  Then go out with your copy of the app-specific recording 
instructions (so you can refer to them step-by-step) and data sheets and find birds to record in a 
location with minimal background noise from cars, trucks, people talking, etc.  Dress 
appropriately for the weather so you will be comfortable, and bring headphones or earbuds if you 
have them so you can listen to your recordings without doing unintentional playbacks. 
 
Useful techniques for making good recordings (rationale is explained here; how-to details are 
provided in the app-specific instructions):   
 
1) Set the record level so that the loudest sounds you are recording are near but do not exceed the 
maximum that can be recorded without distortion:  record level indicators vary for different apps.  
 
2) Make relatively short recordings, for ease of analysis and manageable file size to e-mail the 
recording to yourself, (~10 MB for a one-minute recording; shorter recordings are fine).  (Once 
you've mastered the skills in this lab, you may want to consider making longer recordings in mp3 
format; these will be of lower overall quality, but may allow you to answer questions that can't 
be answered with shorter recordings.) 
 
3) Sight down the phone, pointing the microphone toward the bird.  If there is background noise 
you wish not to record, try to position yourself so your body is between the noise source and the 
bird.  Try to record with as few obstacles as possible between you and the bird:  intervening 
vegetation can cause reverberations that distort the sound. 
 
4) Start recording as soon as you can clearly hear the bird; don't wait for the "perfect" conditions 
to begin your recording, because bird vocalizations are often short, and the bird may fly away. 
Background noises may make your recording less aesthetically pleasing, but if they are at a 
different frequency than the bird, you may still be able to clearly distinguish the bird's sounds.  
Recording from a closer distance is likely to significantly improve the quality of your recordings, 
making the sound of the bird significantly louder in comparison to background noise.  Once your 
recording has begun, you can try to improve conditions by hushing talking classmates, 
repositioning yourself, etc.  As you try to approach a bird more closely, keep the recorder 
running, adjusting your recording level as needed. 
 
5) Your recordings will be most useful for answering questions if you describe the vocalizer and 
behavior you observe AS you make your recordings (especially if multiple species or individuals 
are vocalizing during your recordings).  Try to speak during short silent periods between 
vocalizations, but even if your voice overlaps some bird vocalizations, there is a good chance 
that they'll be at a different frequency than your voice and therefore remain distinguishable.  The 
more you say on the recording and write on the data sheet, the more you will know about the 
birds and the recordings. You cannot count on remembering anything. 
 
6) You will get better recordings on days with little or no wind.  Try to keep any wind from 
blowing directly on the microphone head.  Since wind speed drops off sharply very close to the 
ground, kneeling to hold the microphone as close to the ground as possible (and then pointing it 
at an angle up toward the bird) will help reduce wind noise if the wind is blowing. You can use 
your body or vegetation to shield your microphone from the wind.  Windscreens help to reduce 
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wind noise, and provide additional protection for the microphone head:  it is a good idea to 
permanently leave the windscreen on smartphone microphones.  Some windscreens can get 
knocked off easily, so take care to avoid that. 
 
7) Right after your first recording, and at least periodically after that, play back and listen to what 
you recorded (through headphones or earbuds if possible, to avoid unintentional playbacks). This 
will allow you to catch and correct any problems quickly, including letting you know if you need 
to refine your microphone aim.   
 
8) If the bird that you are recording stops vocalizing, or you lose sight of it but think that it is still 
nearby, playing a short portion of your last recording may well get it to reappear/start vocalizing 
again.  It will probably react as though your phone's speaker is a rival in its territory, so its 
vocalizations and behavior may well be different from before your "playback".  Just before your 
playback, with the recorder running, speak into the microphone to describe what will be played 
(e.g. bird’s own voice, song of its species from an app, etc.), and at the end of the recording, 
describe the bird’s response to the playback, including visual displays.  The playback should be 
kept quite short because responding to playbacks takes extra time and energy from birds, and in 
some cases may disrupt their social systems.  Smartphone playback is not appropriate for 
scientific experiments, as both the recording and the playback may be distorted in ways you 
cannot hear but that are significant to the birds:  for example, undefined characteristics may be 
introduced by recording with a smartphone tailored to recording human speech, and so responses 
to smartphone recordings cannot be accurately interpreted.)   
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PROCEDURE 
 

Sound Analysis (Part 2) 
 
Review the information in the Introduction to this lab, the list under "Questions you may be able 
to answer with recordings made..." in Part 1 of the lab, and your Data Sheet, to help decide your 
focus for analyses and which recordings to e-mail to yourself or to request from your recording 
partners.  Different students may choose to analyze different recordings, or students who worked 
together may choose to divide up analyses of a single recording to answer a question (for 
example, one person may concentrate mainly on frequency measurements and another person 
may concentrate mainly on time measurements in the same recording, or if two birds are 
vocalizing over the same period, each bird’s vocalizations could be analyzed by a different 
student).  How convenient that you will be able to open recordings made on the same 
smartphone, on multiple computers!  If you have headphones or earbuds, bring them to the lab, 
as it can get noisy if everyone's playing their recordings at the same time.   
 
Before the class in which you'll be analyzing your recordings, e-mail them to yourself in WAV 
format, and test your ability to access them on a computer to which you have access, so you will 
be prepared to do this in class (it will likely be helpful to read the instructions for accessing e-
mailed smartphone recordings, in step 5 below). If you find that you are having trouble e-mailing 
recordings to yourself, or opening them on a computer to which you have access, please get help 
with this from your institution's IT staff before the analysis lab. 
 
The following set of instructions is meant to allow you to use Raven Lite 2.0 fairly quickly, but 
the comprehensive user manuals that download with Raven software have a great deal of 
additional interesting and useful information.  The Raven Lite 2.0 User’s Manual is currently in 
preparation; in the interim, you can find useful relevant information in the Raven Pro 1.4 User’s 
Manual, available for download at:  
http://www.birds.cornell.edu/brp/Raven/Raven14UsersManual.pdf 
Raven Pro has a number of capabilities that Raven Lite 2.0 does not have, so not all information 
in this manual will apply.  There is also a Raven Lite 1.0 User’s Guide available at: 
http://www.birds.cornell.edu/brp/RavenLite/RavenLite10UsersGuide.pdf   
But it will not cover some aspects of Raven Lite 2.0 that work more like Raven Pro 1.4.  Further 
questions about Raven Lite and Raven Pro can be directed to:  Bioacoustics Research Program, 
Cornell Lab of Ornithology, 159 Sapsucker Woods Rd., Ithaca, NY 14850, Phone:  607-254-
2199; FAX:   607-254-2460; e-mail:  <raven_support@cornell.edu>.  

 
These instructions have been tested on an iMac Retina 4K computer with a 3.4 GHz Intel Core i5 
processor, running macOS Sierra Version 10.12.6; and on a Dell computer with a 3.41 GHz Intel 
Core i7 processor and an Intel HD Graphics 530 Video Card, running Windows 10 Version 
1703.  The Dell computer was paired with a Dell 23-inch Multimedia Monitor, Model UZ2315H, 
with built-in speakers and a 2.0 MP Full HD Webcam. 
 
The following instructions start with recording your own voice, to become familiar with how 
Raven Lite's spectrograms and oscillograms display sounds.  It will be informative to include 
both a whistle and speech, and sounds that sweep through different frequencies (for example, a 
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"wolf whistle"); you can also imitate the bird sounds you are planning to analyze.  If your 
computer/monitor doesn't have a built-in microphone, you can just use your recording app to 
record 10-20 seconds of your voice on a smartphone, and e-mail the recording to yourself.  If 
you won't be using your computer to record your voice, skip the first step below and start with 
step 2. 
 
1) To prepare to record your voice with the microphone built into your computer/monitor, before 
you open Raven Lite 2.0, set the sound input level for your computer.  On a Mac, do this from 
the menu under the apple in the upper left of the screen:  select System Preferences, then Sound, 
then the Input tab, and then adjust the input volume settings for each sound input method you 
will be using.  Try an initial input volume setting at about 3/4 of maximum.  If you have the 
option to select a “Use ambient noise reduction” option, do so, and if you can choose to show the 
Output volume in the menu bar, it may be convenient to also make that choice.  
 
Fewer PCs than Macs have built-in microphones.  If you can record on your PC, setting sound 
levels will involve something like the following:  Open the Sound settings by clicking on the 
magnifying glass symbol at the lower left of the screen, entering "manage audio devices" in the 
search bar, and pressing <enter>.  In the Sound window that opens, select the Recording tab, and 
then double-click on the name of the recording device you intend to use, to open its Properties 
window; you may need to enable the device by selecting "Use this device (enable)" in the drop-
down Device usage menu at the bottom of the window.  On the PCs in our computer lab, we 
choose Echo Cancelling Speakerphone as the sound input device.  Once you have opened the 
Properties window for your recording device, use the Levels tab to adjust the recording level to 
3/4 of maximum (you can return to re-adjust this if needed), and click "OK".  The Playback tab 
in the Sound window has a similar set of choices of playback (speaker) devices with Properties 
windows in which the speaker level can be adjusted after clicking on the Levels tab.  The speaker 
in our monitors is activated by selecting Dell UZ2315H Intel(R) Display Audio as the speaker 
device.  Click "OK" to accept your new settings, and then you can close the Sound window.   
 
2) Open Raven Lite from your dock icon, Applications folder, or other location on your 
computer:  likely its icon will show a flying black raven in front of a purple cloud.  If there are 
any new updates, you will be asked for permission to install them. Then you will have a window 
with a bunch of symbols on control buttons across the top and a big empty purple-blue area 
below.  If you hold your cursor over a control button, its function will be displayed below the 
cursor.  You can maximize the display to fill your screen, in the standard way for your computer 
(on a Mac, the controls are the colored circles in the upper left corner of the display:  + (green 
circle) to maximize (and restore) display size, - (yellow circle) to minimize (which sends the 
window down to the dock, from where it can be retrieved by clicking on it), and X (red circle) to 
close the window (if you click on the X for the overall Raven Lite 2.0.0 window, you will quit 
the program); in Windows, the corresponding controls (a square outline to maximize/restore 
display size, - to minimize, and X) are in the upper right corner).  If you won't be using your 
computer to record your voice, now skip to step 5).  
 
3) Click on the microphone symbol button near the upper left corner of the window.  An inner 
window will appear, titled Configure New Recorder.  Choose to record to Memory.  For Input, if 
your computer has a built-in microphone, on Macs choose Default Audio Device (JavaSound) 
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OR Built-in Microphone (JavaSound) as your input device (both work equally well on the Macs 
in our computer lab).  On PCs, choose Default Windows Audio Device (JavaSound) or the name 
of the audio device you are using (in our case, Echo Cancelling Speakerphone); both work 
equally well on our computer lab PCs, but if you're having problems on your computer try the 
other option(s).  Use 44100 Hz as the Sample Rate, with 16-bit signed PCM Sample Format, and 
record just to a single channel (either Left or Right is fine, but not both at once).  Then switch 
over to the Display rectangle or tab near the top of the window, and type in a new number to 
change the Buffer Size to 60 sec (the Update Rate should remain at 10 Hz, Latency at 0 seconds, 
and Window Preset at Default 1.3 Power), and click OK.  Then (at least the first time you do 
this) you may have another inner window asking if you want to keep, replace, or merge 
annotation columns in a table; you may choose Keep and then indicate that you want to use the 
same answer in the future.  Then a window titled Recorder 1 will appear.  You can maximize this 
window so it takes up the whole inner area.   
 
4) a. Click on the triangular green arrow in the lower left corner of the Recorder 1 window and 
start to speak, whistle, etc. into the built-in microphone.  An oscillogram of the sounds you are 
making will appear in the top (Waveform) panel.  Don't worry if the zero axis is offset from the 
center of the panel, or if the display does not take up the whole window:  the Zoom to All 
selection in step 6.a. below will center and fit it properly.  A very colorful spectrogram 
corresponding to the oscillogram will appear in the bottom (Spectrogram) panel. The waveform 
and spectrogram views of the sound will originate at the right edge of the window and scroll 
across to the left as your recording continues.  Record 10-20 seconds of sounds, and then click 
the green square that replaced the green arrow to stop recording.  Note that if you stop recording 
and then start again, everything you previously recorded will be erased.  (If you record for longer 
than your 60-second Buffer Size, earlier parts of the recording will be erased.)  You will not be 
able to simultaneously open more than one Recorder window.   
 
b. To listen to your recording, click on the "Play" button, the leftmost gray arrow to the left of 
the word “Rate” in the top set of buttons at the top of the Raven Lite window.  You will likely be 
able to use the standard keys or menu bar symbols to adjust volume:  speaker symbol with 3 
curved lines radiating to the right to increase volume or reveal a slider bar to adjust volume; 
speaker symbol with a single curved line to the right to decrease volume.  On our computer lab 
Macs, which are set on mute as the default, it's necessary to hold down the fn key (in the cluster 
of keys above the up, down, right, and left arrows on the keyboard) while depressing the relevant 
volume adjustment key.  On our computer lab PCs, in addition to the keyboard keys, the speaker 
sound level can be adjusted by holding a finger down on the relevant volume adjustment symbol 
on the solid monitor frame below the screen.  There is a nearby microphone symbol with an x 
beside it to avoid touching, as that will turn off the microphone (indicated by a light next to the 
symbol).  (You may listen to your recording through headphones or earbuds if your computer 
can connect to them.) 
 
5) The next steps provide information on how to analyze a recording of your own voice, or your 
smartphone recordings, or sound files from the Examples folder that downloads with Raven Lite 
2.0.  Stored sound files may be accessed by selecting Open Sound Files in the File menu; the 
initial default location is the Examples folder, but you can use the drop-down menu below the 
default entry to access sounds stored in different locations.  The Open Recent Folder and Open 
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Recent Sound Files options in the File menu provide useful shortcuts to get to recently-opened 
sound files or folders.  
 
To access e-mailed smartphone recordings through Raven Lite, you need to download them onto 
the computer you are using for analyses. A Download option may be displayed somewhere next 
to your attachment, or you may need to right-click (or control-click) on the attachment to get a 
drop-down list with a Download option, or a Save As... option from which you can choose your 
Downloads folder as the destination. 
 
You can open downloaded files in Raven Lite by going to the File drop-down menu, choosing 
Open Sound Files..., and then navigating to your Downloads folder.  On a Mac in a shared 
computer laboratory, going to your personal Downloads folder may require first choosing 
macHD on the drop-down menu (may be written differently, e.g. Mac HD), then double-clicking 
on Users, then double-clicking on your individual User folder, which should have a little house 
symbol next to it, then double-clicking on Downloads, and then double-clicking on the file you 
want to open.  On a PC in a shared computer laboratory, navigate down the drop-down list to 
your personal folder, which will have your user name next to it, double-click on it, then double-
click on the Downloads folder in the next list that appears, and then double-click on the file you 
want to open.  If your personal folder isn't on the initial drop-down list, you can repeatedly click 
the "Up one level" button next to the drop-down menu to get to This PC.  A Downloads option 
will appear in the list for This PC; double-click on it, and then double-click on the file you want 
to open. 
 
When you first open a sound file, a set of Configure New Sound Window options will appear.  
Keep the default settings and click OK.  If you get a pop-up window with the message that 
Raven Lite is unable to read and decode the entire file, you can ignore it (just click on OK), 
unless once opened your sound actually appears to be shorter than it should be, in which case 
you can re-open your sound and select the "Page Sound" option (instead of “Open Entire 
Sound”) with the options below “Page Sound” left at their default settings.  
 
6) The sound window will have an oscillogram (= waveform) will appear in the top (Waveform) 
panel, and a spectrogram corresponding to the waveform will appear in the bottom 
(Spectrogram) panel. There are a couple of suggested adjustments that must be made separately 
for the Waveform and Spectrogram views.  You may select each view either by clicking on its 
name in the Views list on the left, which will cause the name to appear against a pale purple 
background, or by clicking in the narrow vertical bar at the left edge of the panel that shows each 
view; the bar will then get a light purple filling.  (Simply unchecking a View's name in the Views 
list will cause it to disappear, which allows the other View to be displayed in more detail, but is 
not suggested at this point.)  With the Waveform view selected, click on the Zoom to All control 
button (a red square with arrows pointing out from each corner) in the second row of control 
buttons at the top of the Raven Lite window.  This will cause your recording to fill the entire 
Waveform panel.  Then select the Spectrogram view.  Because it takes a while to become 
accustomed to the color coding in the default rainbow spectrogram (and because you can't print a 
color spectrogram accurately on a grayscale printer), we suggest using a grayscale color scheme 
for now.  The color map control button is the leftmost in the bottom row of control buttons at the 
top of the Raven Lite window:  it's a small varyingly-colored rectangle (rainbowed in the default 
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view).  Click the control button, drag up the slider bar that appears, and select the top, grayscale 
option.  In grayscale, the louder the sound, the darker it will be.  If the background of your 
spectrogram is very dark, next go to the Brightness (sun symbol) slider right of the color map 
control button and drag it to the right until the sounds are easily distinguished from the 
background (but note the whole display will fade, so your sounds will also start to disappear if 
you go too far). 
 
7) a. Click on the Play button, the leftmost arrow to the left of the word “Rate” in the top set of 
buttons.  Your sound should then play so that you can hear it, with a moving scroll bar to show 
which part of the sound is being played (adjust your computer’s speaker volume/sound output 
level if necessary with the standard keys or menu bar symbols).  You can pause the playback by 
clicking on the Play button again, but to restart it from the beginning, first click on the solid 
square control button to the left of the word “Rate.”  After that button is clicked, try typing a 
different number into the Rate box to play your sound more quickly (numbers greater than 1), or 
more slowly (decimal fractions less than 1).  You will hear that at faster playback rates the 
frequency also rises, and the frequency falls at slower playback rates (though the spectrogram 
and waveform displays will continue to show the original recorded frequency and time scales).  
To restore the playback rate to normal, enter 1 in the Rate box and press <enter>. 
 
b. To make a part of your sound fill the whole window, so you can see it in more detail, Select it 
in the waveform panel by putting your cursor at the start of the part that you want and holding 
down the mouse button while you drag the cursor to the end of the part that you want, then 
releasing the button.  (Hint:  place your cursor above or below the horizontal 0 axis to make the 
selection; otherwise it is too easy to move the axis around instead of making the selection you 
intend to make.)  If you make a mistake or want to get rid of this “Selection,” Click on the Clear 
Active Selection(s) button, the rightmost button in the middle row of control buttons above your 
window, and select "Yes" in the window that pops up next.  
 
c. Click on the Zoom to Selection button above the window (it’s a square with arrows pointing in 
at each corner, just left of the Zoom to All button).  The selected part of the sound will now fill 
both the waveform and spectrogram panels.  You can incrementally stretch or shrink your view 
using the "+" and "-" buttons in the lower right corner of the Sound window:  the horizontal axis 
buttons stretch or compress the time axis, and the vertical axis buttons stretch or compress the 
vertical axis of whichever View you have selected most recently (see the third sentence of 6.a. 
for a reminder on how to toggle between views). If your selected sound moves off the window, 
use the slider bars at the bottom or right side of the window to find it again.  
 
d. Stretch the waveform panel's vertical axis, if necessary, for your sound to be easily perceptible 
above and below the zero axis. Then stretch the time axis by repeatedly clicking the + button on 
the right end of the horizontal slider bar until the waveform is resolved into a sine wave (or a 
wave that looks like a sine wave with superimposed peaks and valleys).  A sine wave is the basic 
unit of sound, a smooth wavy curve that alternates extending symmetrically above and then 
below the horizontal axis; higher amplitude (louder) sounds have higher peaks and lower valleys 
in their sine waves.  Pure-toned sounds (like whistles) resolve into simple sine waves; more 
complex sounds (like human speech) resolve into superimposed sine waves, with more complex 
shapes.  You can return your sound to its original scale by clicking the Zoom to All button, 
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which is next to the - button, and looks sort of like the letter “H” (on the horizontal axis) or "I" 
(on the vertical axis).   
 
e. Clear any active Selections with the Clear Active Selections button, at the right end of the 
middle row of control buttons above the sound window.  Then select the Spectrogram view and 
experiment with the effects of moving the first two sliders on top of the display, controlling 
Brightness (sun symbol) and Contrast (split black and white symbol).  The third slider, Focus or 
Spectrogram Window Size, is symbolized by three stacked horizontal lines.  This characteristic 
also may be referred to as spectrogram resolution or spectrogram sharpness.  The slider controls 
the trade-off between accuracy in the spectrogram's time (horizontal) and frequency or pitch 
(vertical) dimensions:  changes require a new spectrogram to be made; unlike the other two 
sliders, these changes will happen only after you release the slider button.  Experiment with 
different settings to find a point at which your spectrogram shows informative characteristics of 
the sound.  A whistle should appear as a single, relatively narrow frequency band; human speech 
should clearly show harmonics; and the onsets and ends of sounds should be precise and easy to 
see.  Note that the appropriate Spectrogram Window Size settings will differ for different sounds, 
so you should re-experiment with these for each new sound you analyze and each new scale at 
which you are going to analyze a sound.  
 
8) To print an image of your Raven Lite window (on which you will be neatly and accurately 
writing the measurements you make below; see Appendix E for examples):  First hide the 
Views/Channels/Components panel on the left of the window by clicking on the tiny left-
pointing arrow at the upper right corner of that panel:  this will allow your waveform and 
spectrogram panels to take up the entire area of the window (note that this panel is, however, left 
visible in the Appendix E examples).  Clear any active Selections, and click on the Stop 
Playback button to clear the vertical marker that shows the location in a paused playback.  Then 
select the Spectrogram view, so that the spectrogram panel's values for your slider settings are 
displayed at the top of the window.  Then, under the File menu, select Export Image Of and in 
the list that appears, choose Raven Lite Window… and then choose JPEG file format, give the 
image a descriptive name if you’d like, and save the exported image on your Desktop (this may 
require a click to open your Desktop and a second click to save the file there) or somewhere else 
where you can easily access it.  On the Macs in our computer lab, double-clicking on the image 
file on the desktop opens it in Preview, and selecting File, Print... and then Show Details at the 
bottom of the Print window allows the choices Scale to Fit and Print Entire Image.  (Selecting 
Print directly from the File menu in Raven Lite does not allow scaling options, thus saving the 
image into a JPEG file is preferable.)  On our computer lab PCs, right-clicking on the image file 
allows a choice of programs to open it (Open with... option).  We've used Adobe Acrobat DC, 
which converts the file to PDF format prior to printing it.  Check in the Print preview window 
that the entire window will be printed; if not, you may need to select, de-select, or adjust the 
option that fits the image to the paper.      
 
9) Assignments for each student to hand in, in addition to your group's original Data Sheet: 
 
a. Two printed images of the same sound at different time scales, as shown in Appendix E 
Figures 1 and 2:  you can expand one interesting part of a vocalization to fill a whole window, or 
compress a longer part of your recording to show information such as the pattern of durations of 
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silent periods that separate vocalizations.  Indicate on the image of the longer sound, which 
portion is expanded in the other image (sample labeling at the bottom of the Appendix E Figure 
1 image). 
 
b. Label your images with at least two measurements of duration and two measurements of 
frequency, and label a set of harmonics, if these appear in your recorded vocalizations, and any 
evidence that a bird is singing harmonically unrelated sounds simultaneously with the two sides 
of its syrinx (this didn't happen in the Appendix E examples, but there is likely an example in 
your textbook), and label/comment on any other phenomena of interest that you notice (see 
sample labels on Appendix E figures). 
 
c. A paragraph describing which question(s) your recording allowed you to answer, and what the 
answer(s) are, with reference to labeled information on your printed images.  
 
10) To make measurements of sound characteristics:  
 
a. Make frequency measurements by placing the cursor on the spectrogram so the horizontal bar 
of the cursor cross (or the tip of the pointer arrow, if a pointer arrow is displayed instead of a 
cursor cross) is at the frequency you want to measure.  The frequency will be displayed at the 
bottom of the Raven window.  Alternatively, you can drag the purple/red line up from the bottom 
axis of the spectrogram graph to the point at which you want to know the frequency, and the 
frequency will appear in blue beside the vertical axis:  this method is particularly useful to 
compare frequencies of different sounds, as you can easily see whether they all intersect the 
same line.  
 
b. To measure time durations, the vertical bar of the cursor cross can be lined up with the start, 
and then the end of the sound you want to measure, to get the start and end times displayed at the 
bottom of the window; then you can subtract to obtain the total duration.  If there is minimal 
background noise, time measurements are likely to be most easily made from the waveform 
panel, using the spectrogram below to verify the sound that you are measuring.  Alternatively, 
you can drag the purple/red line from the left or right boundary (it may appear on either side) of 
either the waveform or spectrogram to each time you want to measure, and the time 
measurement (in seconds) will appear in blue under the horizontal axis.  
 
c. To compare relative amplitudes, there is a purple/red line at the 0 axis of the waveform panel 
that can be dragged up or down:  relative amplitudes will be displayed in kU units in blue to the 
left of the vertical axis.  To return this line to the zero point, go to the vertical set of control 
buttons in the lower right corner of the Sound window and first click on the box with the 
purple/red horizontal line, above the + symbol, and then click on the I shape (Zoom to All 
button) below the - symbol.  
 
Note that Raven Lite will generally display frequency and time measurements at the bottom of 
the window with more decimal places than can accurately be determined, and that these may be 
slightly different from the numbers displayed beside the axes.  More accurate measurements can 
be made at finer scales, and you can use Spectrogram Window Size settings that more accurately 
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show either frequency or time values; the Raven User’s Manual/Guides (Charif et al., 2006 and 
2010) have additional information on the accuracy tradeoff between time and frequency.  
 
11) You can use the "Save Sound ___ As" command from the File menu to save a sound to the 
desktop or to a folder within your computer. Save your file in 16-bit WAV format, which will 
correspond to the phone recordings you made. The Raven 2.0 Examples folder of sample sounds 
may be the default destination on the drop-down menu (you can create a new subfolder for your 
recordings within that folder), but select a different destination if you do not want your file to 
have a home there.  On a shared computer, your Desktop folder is one of the options within your 
personal User folder.     
 
Additional options: 
 
A. You can manipulate a sound (or some part of it), but to do that without changing the original 
file, select the part you want (or the whole sound) in the waveform panel. Then use the Raven 
Edit menu to Copy the selected sound, create a new window by selecting New in the File menu 
and then Sound Window in the list that appears to the right of "New", and then use the Edit menu 
to Paste the sound into the new window.  Instead of the menus, you can use the standard 
keystroke shortcuts.  Now, go to town with the new window.  You can create a synthesized 
sequence by repeatedly pasting in the same sound, for example, or use Cut or Delete (under the 
Edit menu, or the keystroke shortcut) to cut out part of a sound. You can Undo some commands 
under the Edit menu, too.  If you want to save your manipulated sound, be sure to use the "Save 
Sound __ As..." option under the File menu; otherwise it will be gone if you open a new Sound 
Window. 
 
B. Raven Lite can save measurements corresponding to different Selections in a Selection Table 
below the spectrogram panel.  You can reveal the Selection Table by clicking on the tiny 
upward-pointing arrow above the Table 1 tab at the base of the sound window. Clicking the 
downward-pointing arrow will reverse the action of the upward-pointing arrow.  To see both the 
Selection Table and the waveform and spectrogram panels, put the cursor between or just to the 
right of the tiny arrows and then drag the double-headed arrow that appears up or down. 
 
C. When making selections, a single point can be Selected, or the cursor can be dragged to select 
a larger area, which in a spectrogram will have defined time and frequency boundaries whose 
values will appear in the Selection Table (so be sure to place them accurately).  Note that only 
the times will be measured accurately for a Selection made in the waveform panel, as the full 
range of possible frequencies will be reported as the Maximum and Minimum in the Selection 
Table.  To move one border of a Selection after you have made it but before it is Committed, or 
to change boundaries of uncommitted Selections made on spectrograms by dragging a corner, 
hold down the “Shift” key.  Once you have made a Selection, you can hit the Enter/Return key to 
“Commit” it.  An Annotate Selection box will appear in which you can enter notes about your 
Selection; you can leave the first checkbox unchecked.  You can uncheck the "Show this dialog 
whenever a selection is committed" to avoid getting this box for subsequent Selections.  Once a 
selection is Committed, you can make and Commit additional Selections by the same method.  
For each Selection, the Selection Table will show identical time and frequency measurements for 
the waveform and spectrogram views.  To delete a Selection that has already been committed, 
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click its boxes in the Table’s Selection column, which should turn red, and then click on the 
Clear Active Selection(s) button at the end of the middle row of buttons at the top of the Raven 
window, and click on Yes in the window that pops up.  Selection Tables can be saved with 
commands under the File menu.  
 
D. If you have navigated away from the Examples folder and want to return, and if the Examples 
folder does not appear in the Open Recent Folder options, you will need to navigate back to 
where it is stored.  On our computer lab Macs, the Examples folder is stored within the Raven 
Lite 2.0 folder, within the Applications folder, within macHD.  On our computer lab PCs, the 
Examples folder is stored within the Raven Lite 2.0 folder, within the ProgramData folder, 
within OS Disk (C:), within This PC.  Because the ProgramData folder does not appear in the 
drop-down menu for OS Disk (C:), after you select OS Disk (C:), you'll need to type 
ProgramData into the File Name bar and press <enter> to proceed to the Raven Lite 2.0 folder. 
 
 



! 18!

Acknowledgements 
 

Sound analysis instructions include information from the Raven Lite 1.0 User’s Guide.  We 
thank Russ Charif, Tim Krein, Greg Budney, David Spector, Kyle Testerman, and Donald 
Kroodsma for their very helpful reviews of earlier versions of this lab and suggestions for 
improvements, Dean Hawthorne for his longtime Raven development work, Ben Thomas for his 
work on developing Raven Lite 2.0, and Michael Pitzrick for his excellent Raven Lite 2.0 
technical support.  Peter Szul, Vivian Novak, Christine Alexandre, Tom Bohlke, and their staff 
provided helpful IT support and advice at Central Connecticut State University.  Karli 
Walczewski Searle and Jim Searle helped test and refine Android phone instructions.  We thank 
Jed Burtt and Jameson Chace, editors of this Manual, for inviting the submission of the original 
and revised versions of this lab, for organizing WOS and NAOC workshops where exercises 
were demonstrated and tested, and for their wise advice and support.  Workshop participants, and 
students in Central Connecticut State University Ornithology, Animal Behavior, and Natural 
History classes have helped to test multiple versions of these instructions.    

 
References 

 
Catchpole, C.K. and P.J.B. Slater.  1995.  Bird Song:  Biological Themes and Variations.  
Cambridge University Press, Cambridge, England. 
 
Charif, R.A., D.W. Ponirakis, and T.P. Krein.  2006.  Raven Lite 1.0 User’s Guide, and Quick 
Start Guide, Raven Lite 1.0.  Cornell Lab of Ornithology, Ithaca, NY. 
 
Charif, R.A., A.M. Waack, and L.M. Strickman.  2010.  Raven Pro 1.4 User’s Manual.  Cornell 
Lab of Ornithology, Ithaca, NY. 
 
Gill, Frank B.  2007.  Ornithology, 3rd ed.  W.H. Freeman and Company, New York, NY. 
 
Hopp, S.L., M.J. Owren, and C.S. Evans (Eds.).  1998.  Animal Acoustic Communication:  
Sound Analysis and Research Methods.  Springer-Verlag, Berlin and New York, NY. 
 
Kroodsma, D.E. and E.H. Miller (Eds.). 1982.  Acoustic Communication in Birds.  2 vols.  
Academic Press, New York, NY. 
 
Kroodsma, D.E. and E.H. Miller (Eds.).  1996.  Ecology and Evolution of Acoustic 
Communication in Birds.  Cornell University Press, Ithaca, NY. 
 
Kroodsma, D.E.  2005.  The Singing Life of Birds:  The Art and Science of Listening to 
Birdsong.  Houghton Mifflin, Boston.   
 
Marler, P., and Slabbekorn, H.W.  2004.  Nature’s Music:  The Science of Birdsong.  Elsevier 
Academic, Amsterdam. 
 
Pieplow, N.  2017.  Peterson Field Guide to Bird Sounds of Eastern North America.  Houghton 
Mifflin Harcourt, New York, NY. 



! 19!

 
Robbins, C.S., B. Bruun, H.S. Zim, and A. Singer, Latimer, J.P., Nolting, K.S., and Coe, J.  
2001.  Birds of North America, revised and updated edition.  St. Martin’s Press, New York, NY. 
 
The Birds of North America Online, birdsna.org, Cornell Lab of Ornithology. 
  



! 20!

APPENDICES 
 

A. Instructions for downloading and using the Twisted Wave recording app, for iPhone 
and iPad users 
 
B. Instructions for downloading and using the RecForge II recording app, for Android 
phone and tablet users 
 
C. Instructions for downloading Raven Lite  
  
D. Template for data sheet to use while making recordings 
 
E. Example set of labeled oscillograms/spectrograms at two different time scales, to be used 
as a model for lab assignment to hand in  
 
F. Pros and cons of recording with smartphones, and equipment and software suggestions  
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APPENDIX A:  For iPhone and iPad users:  Download and Use of TwistedWave Recorder 

Download the TwistedWave Recorder app (TwistedWave Software Ltd).  It allows export to 
email and iTunes file sharing, allows you to control the gain when an external microphone is 
used, and exports MP, AIFF, or WAV formats (we'll be using WAV format). The free version 
(Recorder) should work for this exercise (you don't need TwistedWave Audio Editor, which is 
not free).  A microphone icon in front of a blue ball will appear on your desktop; tap it once to 
open the app.  Check the settings (tap the gear wheel icon in the lower right corner of the screen) 
to make sure all options are in the "off" position.  "Help" next to the gear icon has information on 
additional features. 
 
Make and listen to a test recording while you are still inside, to make sure everything is 
connected properly and to practice aiming the microphone and adjusting the recording 
amplitude.  Use the windscreen on an external microphone, and insert the microphone pin 
straight into the appropriate jack on your phone, making sure it goes all the way in (be careful 
when inserting and removing microphones to push or pull the pin straight into or out of the 
phone jack; do not push or pull at an angle, which has been known to cause the pin to break off 
inside the phone).  Some smartphone cases block the microphone from plugging in adequately; 
be prepared to remove the case if necessary to get the mike clicked into place.  Fully charge your 
phone before the lab, and have least 50 MB of memory available.  Set screen brightness to 
maximum to see the screen while outside. 
  
NOTE:  The instructions that follow relate to the app as of this writing, but the app may have 
changed before you do this exercise. If the app does not appear on your phone or tablet as we 
describe it, please just follow the prompts in the app, or use the “Help” feature. 
 
1)! To prepare to record:  a. Tap the “+” on the lower left.  b. Choose “44100 Hz” and “Mono”.       

c. Tap the red ball on the bottom of the screen to begin the recording, and sight down the phone 
to point the microphone toward the bird.  The sound will be displayed in a pair of slightly offset 
moving oscillograms.  If you are not using an external microphone, you can use headphones to 
monitor as you are recording (and to adjust your aim so the sound is as loud as it can be):  the 
"Monitor" in the lower right should be in the "on" position (green background showing), and the 
amplitude of the headphones can be controlled with the slider above the recording display.  (If 
you are not using headphones make sure the “monitor” switch on the lower right of the recording 
screen is off, or you will get feedback.) 

2)! If you are using an external microphone:  After you tap the red ball, tap the Pause button (it has a 
pair of short vertical lines).  Then use the Input Gain slider below the oscillogram to set the 
recording level so that the loudest sounds extend to just barely into the red area of the sound 
level meter on the right of the oscillograms.  (The slider will probably not show up unless you 
have an external microphone plugged in to your phone.)  You will need to make this adjustment 
for each new subject you record, or if the distance between you and your subject changes. Then 
tap Pause again to begin recording.  Unless the bird is very loud or very close you will probably 
be setting the slider all the way to the right.  Unfortunately, headphones seem not to work to 
monitor during recording if an external microphone is being used, even if you use a splitter.  
Fortunately, you can use the oscillograms that spool across the screen as you record, as an 
indicator of adequate amplitude:  sound waves should extend perceptibly above and below the 
central line, but not more than 3/4 of the way to the top or bottom edge of the display. 
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3)! Start your recording as soon as you can clearly hear the bird, and then, as you continue to record, 
move in stages progressively closer to the vocalizing bird, adjusting your input gain as needed.  
Speak during the short pauses between vocalizations (just let the recording continue to run) to 
identify the bird that just vocalized/describe its behavior.  If there is background noise you wish 
not to record, or even a slight breeze, try to position yourself so your body blocks the noise 
source or wind; do your best to keep any wind from blowing directly on the microphone head. If 
the wind is strong, try kneeling to hold the microphone as close to the ground as possible (and 
then point it at an angle up toward the bird). Try to minimize obstacles between you and the bird. 

4)! Keep the recording under 1 minute.  At the end of each recording, speak into the microphone to 
record the date, time, location, species (or descriptive characteristics, if you are unsure of the 
species), recordist's name, questions your recording may allow you to answer, and other relevant 
information (e.g. behavior).  

5)! Tap the square to end the recording.  If you tap the red ball again, you may start recording at the 
end of where you left off (or even in the middle of your previous recording, if you tap the 
oscillogram before you tap the red ball).  However, this will cause some confusion about whether 
the sounds you recorded were continuous, so we advise against it, and advise that you take care 
to avoid doing this by mistake when you are playing back a recording.   

6)! After your first recording, use earbuds or headphones to play back and listen to it to catch and 
correct any problems quickly.  If your microphone plugs into your phone’s headphone jack, you 
will need to remove it to plug in the headphones (or to hear your recording on the unit's 
speakers):  put the microphone in a pill bottle to protect it and so it does not get lost.  Also 
periodically check later recordings to make sure problems have not arisen.  If you do not have 
earbuds or headphones, you can listen on the phone’s speaker, but keep the volume minimal to 
avoid affecting the behavior of the bird you're recording.  If you want to delete a recording, tap 
"Back" in the upper left of the screen, which will take you to your complete list of recordings.  
Tap "Edit" in the upper right to get small empty circles to the left of each recording name.  
Tapping on a circle will fill it in, and then a tap on Delete at the bottom of the screen will delete 
all recordings with filled-in circles.  If you want to keep your recording, tap the name “Recording 
#” at the top of the screen and replace it with a descriptive filename.  

7)! Fill out the Recording Data Sheet for this recording (with writing help from a partner). 
8)! Tap "Back" in the upper left of the screen to make a new recording or look at another file.  Take 

turns making recordings so that every student in your group gets to record. 
9)! If the bird that you are recording stops vocalizing, or you lose sight of it but it's still nearby, a 

short playback of your last recording may well get it to reappear/start vocalizing again (keep the 
playback period brief to minimize disruptions to the bird). Just before your playback, with the 
recorder running, speak into the microphone to describe what will be played (e.g. bird’s own 
voice, song of its species from an app, etc.), and at the end of the recording, describe the bird’s 
response, including visual displays, after the playback.   

10)!To export a file for analysis, open the file, then tap the box with the arrow pointing up out of it in 
the upper right of the screen.  A list of Audio Export options will appear.   

a.! On that list, tap Format, then tap WAVE in the top set of Format Options, and then tap 
Compression/Bit Depth at the bottom of the screen.   

b.! Tap 16 bits on that list.  Then tap Format in the upper left to get back to the previous 
list, and then tap Audio Export in the upper left to get back to the list before that.  Your 
selections will likely be saved for future exports.   

c.! Tap Send by Mail…   
d.! Type in your e-mail address and tap Send to send the file by email to your account.  



! 23!

APPENDIX B:  For Android Phone and Tablet Users:  Download and Use of RecForge II 
  

Download the RecForge II Lite – Audio Recorder app (by Dje073) from Google Play (or another 
source; it’s also available at https://www.apk4fun.com/apk/2128/ ).  It allows export to email or 
Bluetooth, allows you to control the gain, and exports MP, OGG or WAV formats (we will be 
using WAV format). The free version (not the Pro version) is fine, since you will be making 
relatively short recordings.  A microphone icon will appear on your desktop; tap it once to open 
the app. 
 
Make and listen to a test recording while you are still inside, to make sure everything is 
connected properly and to practice aiming the microphone and adjusting the recording 
amplitude.  Use the windscreen on an external microphone, and insert the microphone pin 
straight into the appropriate jack on your phone, making sure it goes all the way in (be careful 
when inserting and removing microphones to push or pull the pin straight into or out of the 
phone jack; do not push or pull at an angle, which has been known to cause the pin to break off 
inside the phone).  Some smartphone cases block the microphone from plugging in adequately; 
be prepared to remove the case if necessary to get the mike clicked into place.  Fully charge your 
phone before the lab, and have least 50 MB of memory available.  Set screen brightness to 
maximum to see the screen while outside. 
 
NOTE:  The instructions below relate to the app as of this writing, but the app may have changed 
before you do this exercise.  If the app does not appear on your phone or tablet as we describe it, 
please just follow the prompts in the app, or use the “Help” feature. 
 
Before you get started: 
1.! Tap the three boxes in the upper left 
2.! Select “Settings”, then “Audio Record”. 
3.! Select (by tapping) from the drop down menus:  

a)! File Format:  select “WAV”,  
b)! Channel Configuration:  select “Mono”  
c)! Sample Rate:  select “44kHZ” 

To make a recording: 
1)! Tap the red circle on the bottom of the screen to start the recording. 
2)! Sight down the phone to point the microphone toward the bird.  Use the input gain slider, a 

silver dot on a gray line, to set the recording level so that the loudest sounds you are 
recording make the sound level meter bar extend to near, but still inside, the edge of the 
sound level meter.  The sound level meter bar should not get into the white zone.  As you 
change the slider position, the “dB” measurement shown over the bar will change.  Once you 
find a good position, you can write down the dB measurement and begin a new recording 
that doesn’t have the test period at the start:  the slider should maintain its position, but if it 
doesn’t, you recorded the dB and so can move it there quickly.  You will need to readjust the 
input gain for each new subject you record, or if the distance between you and your subject 
changes. 

3)! Start your recording as soon as you can clearly hear the bird, and then, as you continue to 
record, move in stages progressively closer to the vocalizing bird, adjusting your input gain 



! 24!

as needed.  Speak during the short pauses between vocalizations (just let the recording 
continue to run) to identify the bird that just vocalized/describe its behavior.  If there is 
background noise you wish not to record, or even a slight breeze, try to position yourself so 
your body blocks the noise source/wind; do your best to keep any wind from blowing 
directly on the microphone head. If the wind is strong, try kneeling to hold the microphone as 
close to the ground as possible (and then pointing it at an angle up toward the bird). Try to 
record with as few obstacles as possible between you and the bird.   

4)! Keep the recording under 1 minute.  At the end of each recording, speak into the microphone 
to record the date, time, location, species (or descriptive characteristics, if you are unsure of 
the species), recordist's name, questions your recording may allow you to answer, and other 
relevant information (e.g. behavior).  

5)! Tap the square to end the recording.  If you tap the Pause symbol you can add to the end of 
the recording by tapping the circle again. 

6)! To rename the file tap on the pencil in the upper right.  To delete the file, you can tap on the 
trash can.  Tap on the up arrow to go back to the directory page. 

7)! Fill out the Recording Data Sheet for this recording (with writing help from a partner).  The 
default filename on RecForge Lite II is the date and the time, so this will help you match the 
recording with your observations. 

8)! To listen to the recording just tap on its filename.  In Playback mode, the blue line with a dot 
is a scroll bar that allows you to move to different points in your recording.  The oscillogram 
of your recording is another way to check you are getting a recording without removing the 
microphone. 

9)! After your first recording, use earbuds or headphones to play back and listen to it to catch 
and correct any problems quickly.  If your microphone plugs into your phone’s headphone 
jack, you will need to remove it to plug in the headphones (or to hear your recording on the 
unit's speakers):  put it in a pill bottle to protect it and so it does not get lost.  Also 
periodically check later recordings to make sure problems have not arisen.  If you do not 
have earbuds or headphones, you can listen on the phone’s speaker, but keep the volume 
minimal to avoid affecting the behavior of the bird you're recording. You can adjust the 
volume of the playback by tapping the blue headphones button, then the volume dropdown, 
and moving the volume slider while the recording is playing back. 

10)!Return to the directory page by tapping on the up arrow, then tap the red microphone circle to 
make a new recording. 

11)!If the bird that you are recording stops vocalizing, or you lose sight of it but it's still nearby, a 
short playback of your last recording may well get it to reappear/start vocalizing again (keep 
the playback period brief to minimize disruptions to the bird). Just before your playback, 
with the recorder running, speak into the microphone to describe what will be played (e.g. 
bird’s own voice, song of its species from an app, etc.), and at the end of the recording, 
describe the bird’s response, including visual displays, after the playback.  

12)!Take turns making recordings so that every student in your group gets to record.  
13)!To export the file for analysis, open the file (if it is not open already) and tap on the three 

dots in the upper right, then tap “Share”, then “Email”. 
a)! Put your email address in the “To” line. Put the name of the file in the subject line.  
b)! Send email to your account (tap the paper airplane symbol in the upper right). 
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APPENDIX C:  Instructions to Download and Install Raven Lite Sound Analysis Software 
 
In order to use Raven Lite 2.0, you or your institution's IT staff must first download and install 
the demo version of the program. To download the demo, visit 
http://www.birds.cornell.edu/raven 
Click on the Downloads button on the left side of the web page, and then follow the directions 
for downloading that are included on that page.  To use Raven Lite for longer than the 10 
minutes that the demo version will allow, you need to request a free license, using the link that 
will appear on the demo version window; the license number and registration instructions will 
then be e-mailed to you. 
   
Installation Tips 
 
Install the latest 64-bit Java 8 from https://www.java.com/en/download/manual.jsp 
 
Windows -- We recommend installing Raven in the default path. Installing in C:\Program Files 
will not work. 
 
OSX -- We recommend installing and registering Raven when logged in as an administrator. 
  
For assistance and feedback, the Raven support team are very helpful; their e-mail address is: 
<raven_support@cornell.edu> 
 
You can also visit the Raven HELP forum at  http://help.RavenSoundSoftware.com/ 
 
If you have questions about your license, please contact Raven at the email address listed below. 
  
The Raven Team 
Bioacoustics Research Program 
Cornell Lab of Ornithology 
<raven_orders@cornell.edu> 
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APPENDIX D:  Template for data sheet to use while making recordings 
 

Each person in your group should take a turn at recording, and each person should try to have his 
or her own different set of high quality sounds (and a question about them) to work on during the 
analysis part of this lab.  BE SURE TO fill in the “Notes” column right after you make each 
recording, while the behavioral context is fresh in your mind:  list the number(s) of one or more 
of the following types of questions you could answer with each recording, and provide enough 
information to indicate the specific nature of your question:  
1) Timing within or between vocalizations   
2) Coordination between vocalizations of multiple individuals 
3) Changes in vocalizations with changes in behavioral context 
4) Similarities and differences between sequential vocalizations by the same individual 
5) Similarities and differences between vocalizations of different individuals of the same species 
6) Other (describe) 
 

Name(s), recording date & location, & phone type and microphone used (if any):  ____________ 
 
______________________________________________________________________________ 
 
 

Start time Species 
recorded  

Notes on behavior AND questions (1-6 above) 
you can answer with this recording  

Recordist’s 
name 
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APPENDIX E:  Figure 1. Raven Window image with labels added in PowerPoint (hand-write your labels) 
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APPENDIX E:  Figure 2. Raven Window image of a portion of Fig. 1, expanded to fill whole window 
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APPENDIX F:  Pros and cons of recording with smartphones, and suggestions for 
recording apps and microphones 
 
Thoughts on Using Your Smartphone to Record Bird Vocalizations 

 
You cannot do everything on your phone that you would be able to do with a fancy recording 
system, but the unique array of capabilities on your phone allows you to do things that song 
recordists of just a decade ago could only dream of.  Think of the recorder on your phone as 
being like its camera:  you are not going to get a lot of photos taken with your phone published in 
photo magazines, but for taking pictures documenting where you have been, and what you have 
seen, and who you have been with, and then sending those pictures out to your friends, your 
phone is amazing.  The phoneÕs recorder has the same sorts of strengths and limitations.  It is a 
powerful tool if used properly, but like any tool it needs to be used on the right jobs to be 
effective.  

 
LetÕs get to the down side of recording with the phone first:  it is NOT a dedicated system 
specifically designed to pick up and record the fine details of birdsong.  You are not going to 
make a lot of recordings worthy of sending to the Macaulay Library at Cornell.  The phoneÕs 
built-in microphone can pick up surprisingly good detail, particularly with a loud source near the 
microphone, but cannot focus in one direction and so will make less targeted recordings than 
parabolic or shotgun microphones, and will pick up ambient noise from all directions.  It doesn't 
have powered amplification, or the sound-gathering capability of the parabola.  The availability 
and capabilities of external microphones that will work with smartphones are limited, and the 
jacks on the phones are not robust.  Mike pins have been known to break off inside the phones.  
Even with the best currently available external microphones, you will likely be disappointed if 
you are looking to illustrate in detail the self-sung duet of the Veery (in which the two sides of its 
syrinx simultaneously produce independent, non-harmonically related sounds differing in 
frequency and timing), or the soft introductory notes of the Wood Thrush song, or the geographic 
variation in the song of the Chipping Sparrow, or even just to record a distant bird:  it would be 
better to use a traditional recorder with a parabolic or shotgun mike.  

 
The upside of using the phone, however, is tremendous.  The biggest advantage is that you 
already own it, so it is essentially free (as far as birdsong is concerned), and you always have it 
with you. The phone can also do lots of things that most recorders cannot do: 

¥! It has a built-in GPS 
¥! It can hook up to the internet 
¥! It can hold audio and photo bird guides 
¥! It can take photos 
¥! It can talk to other phones 
¥! It is easy to enter text for file names and your notes 
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Equipment and Software Suggestions 
 
In order to use your smartphone to its full potential you have to be smart too.  The following tips 
are based on the conventional (internet) wisdom and a relatively small amount of direct 
observation, but are mostly just common sense.   
 
1. Research the best phones, apps, and external microphones on the internet before you buy 
anything.  The hardware and software are changing so quickly that this is the only way to keep 
up.  We have found that both an iPhone 5S and the cheapest Kindle Fire did a pretty good job of 
recording birdsong.  A fancy Android phone might be even better.  Be aware that voice recording 
apps may be tailored to recording human voices and miss frequencies in avian vocalizations.  
Consider buying an external microphone.  You may find additional helpful microphone options 
for your smartphone by typing a phrase such as Òexternal microphones for [smartphone type]Ó 
into a search engine.  Mikes made especially for phones are small and relatively inexpensive and 
can increase the signal to noise ratio, but you should make sure the one you are considering has a 
relatively uniform (ÒflatÓ) response over the range of frequencies in the sounds you are trying to 
record (biased frequency response is a potential problem for any microphone, including built-in 
phone mikes), and that the mike has sufficient amplification to allow you to record birds from a 
distance adequate to avoid disrupting their behavior.  Using larger microphones not designed for 
use with a smartphone is cumbersome and risky to your phone jack, and you need to check that 
the microphone connector will actually work in your phone jack. The built-in mikes in the 
phones will probably get better and better with time, and that may further reduce the difference 
between the internal and external mikes.   
 
In general, a good microphone for recording bird vocalizations offers a sensitivity rating of -10 
dB (higher negative numbers indicate lower sensitivity), and a frequency response curve that 
fluctuates by only + 2.5 dB between 20 Hz and 20,000 Hz.  It's important to have an open cell 
foam or better windscreen for the microphone.  Directionality is desirable; super-cardioid 
microphones will be the most compact directional microphones.  Smartphones do not supply 
power to microphones, so you will either need to get a microphone that does not require power 
but may not make loud enough recordings, or a microphone powered by batteries that will add to 
its bulk and weight.   
 
The mike we have used is the Edutige EIM-001 iMicrophone Voice Recorder (see 
http://blog.aba.org/2012/05/mic-up-that-iphone-follow-up.html).  It works well with Apple 
phones that have a headphone jack, and with the Android phones we've tried it with, but Edutige 
warns that it's not compatible with some Android phones, so you should contact them to check 
on compatibility before making a purchase (info@edutige.net). In February 2018 it could be 
purchased for $32 directly from Edutige (www.Edutige.net) or for $24.00 from Edutige's official 
Amazon store; Edutige warns that other suppliers are unauthorized and microphones purchased 
from them have had varying problems and are not covered by their warranty.  Its amplification 
greatly increases the signal strength, helpful for recording details of quieter sounds.  It has a 
sensitivity rating of -22 dB.  Its frequency response curve is flat below 5000 Hz, while 
frequencies between 5000 and 10,000 Hz, a range into which some bird songs extend, are 
differentially amplified by up to 3 dB, making them sound relatively louder than lower 
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frequencies that were actually produced by the bird at the same amplitude.  Frequencies between 
10,000 and 20,000 Hz, rarer in birdsong, are recorded with lower amplification than frequencies 
below 5000 Hz. The mike comes with a windscreen that can be left on at all times; avoid 
knocking it off by brushing against clothing, vegetation, etc.; students should be asked to take 
care not to do this. A small drop of glue or small piece of double-sided tape near the base of the 
windscreen may help keep it on, or a stitch through the base of the windscreen with the thread 
then wrapped around the base of the microphone and secured on the other side of the 
windscreen, but of course get permission if it's not your microphone, and be careful not to 
compress or damage the windscreen with your attachment method.  The mike itself is so small 
the biggest risk is losing it (which has happened at least once!).  A pill bottle is a perfect case for 
it.  Walter keeps one in his pocket.  We are sure that there are other good smartphone 
microphones out there.  NOTE:  This mike has been known to break off in the headphone jack, 
and make a mess of it.  We and our students have not had that problem, but we are very careful 
to push and pull the mike straight into and out of the headphone jack, and do not leave it in the 
phone when we are not recording and it might be likelier to get banged.  This mike also worked 
when we tested it with an Apple lightning to headphone jack adapter plugged into the lightning 
jack of an iPhone that had both lightning and headphone jacks.  However, since the Apple 
adapter is not rigid, and a microphone at the end of a floppy connector is difficult to aim and is 
likely to record noise from hand-holding or vibrations if taped to the phone somewhere, a 
microphone that plugs directly into the lightning jack would be preferable; unfortunately, 
currently available options are quite expensive.  
 
2. Make sure that the recording apps you use can export uncompressed files that your sound 
analysis software can use.  Compressed files, for example MP3 formats, will lose information 
that you may or may not be able to hear, but that may be important to birds. Apple products 
support the AIFF format, and some support the WAV format, which are both uncompressed. 
You might want to make sure your Android app exports WAV files, which are uncompressed. 
 
There are a number of choices of recording apps out there.  They have mostly been developed to 
record voice or music, but some work pretty well for birdsong.  Shop around to see what works 
for you.  One iPhone app available in 2018 that works well is the free TwistedWave Recorder 
(TwistedWave Software Ltd.; you don't need the not-free TwistedWave Audio Editor).  It allows 
export to email or iTunes File Sharing, has a variable gain (when an external microphone is 
used), and exports AIFF or WAV (or MP) formats.  One Android app available in 2018 that 
works well is RecForge II (DJE073).  It has a variable gain (when an external microphone is 
used), and exports in the WAV (or MP) formats.  The free version of RecForge II seems to be 
pretty much the same as the pay-for version, as long as you do not record long MP files.  But you 
want to look around.  Some of the ÒBest recording appsÓ articles on the web do not even mention 
these apps, while others rate them highly. 
 
3. Think carefully about how you are going to name your recordings and maintain the notes 
about them.  Speaking the date, time, location and other information into the recorder 
permanently links the information with the recording.  It is so easy to record with your phone 
that it would be easy to get sloppy and lose track of your files.  Some apps back the files up to 
the Cloud, which might be useful if your phone were to get lost or damaged.  You may want to 
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back up the files to a laptop or desktop for analysis, and delete the files off of your phone to 
make more room on the phone. 
 
4. Look for recording apps that do other things like link photos and location information to the 
file, but make sure that the app makes the most important things easy:  making a recording in an 
uncompressed format, naming the file, and uploading files to the cloud or your computer.  Start 
free or cheap.  Try a number of different apps, and do not hesitate to spend a small amount.  The 
app makes a huge difference in the phoneÕs abilities to record, file, and export birdsong. 
 
5. Think about projects that use the strengths of the phone, while not suffering from its 
limitations.  For example, questions of timing and repetition are perfect for the phone.  How does 
the female Carolina Wren time her duet with the male? How many times does the male sing an 
individual song before he changes to another one?  If you are looking at multiple song types, 
record species that have big differences between songs, like Northern Cardinals or Song 
Sparrows. 
 
6. Make multiple recordings over time.  Since you have the phone every day you can easily visit 
the Towhee behind the library several times a week on your way to class, and follow how his 
song changes through the spring. 
 
7. Think big, and involve other people.  You can easily find other recordists or volunteers who 
have identical equipment to yours.  Set them up along a power-line cut during nesting season and 
follow how birds song-match their neighbors.  Or send them out along a gradient of distance 
from a major road to see if the noise affects the dawn chorus.  Or use social media to recruit 
people you do not even know to listen to the Robins waking up as the sun sweeps across the 
landscape.  And then use freely available survey tools to have the time and location data 
uploaded and tabulated by the time you finish breakfast.  You might be able to answer a question 
nobody ever thought to ask before, because they were always working alone or in small groups. 
 
8. Think small, and have fun.  Is that the same Wood Thrush that was here last year?  How many 
times does a singing bird sing from one perch before changing location or song type?  Does it 
start with the same song every morning? 
            
The best thing about your phone is that you do not have to turn it in at the end of the semester.  
But, like Don Kroodsma (2005) warns, be careful when you start recording birdsong.  You might 
find it hard to stop. 
 


